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Comunicazioni e informazioni relative alle norme di sicurezza

Dichiarazione di conformità: 
Edit Pack è conforme alle seguenti normative relative alle 
interferenze e alla compatibilità elettromagnetica EMC: 
• FCC Part 15 Class A
• EN55103 -1, environment E4
• EN55103 -2, environment E4
• AS/NZS 3548 Class A
• CISPR 22 Class A
• ICES-003 Class A

Dichiarazione di conformità canadese:

La presente apparecchiatura Class A è conforme alla 
normativa Canadian ICES-003

Cet appareil numérique de la classe A est conforme à la norme

NMB-003 du Canada.

Dichiarazione di conformità CE:

Digidesign è autorizzata ad applicare il marchio CE (Conformité 
Europénne) su questa apparecchiatura conforme, 
dichiarandone la conformità alla direttiva EMC 89/336/EEC e 
alla Low Voltage Directive 73/23/EEC.

Conformità australiana:

Dichiarazione di conformità FCC:
La presente apparecchiatura è stata collaudata e risulta 
conforme con i limiti previsti per i dispositivi digitali 
appartenenti alla Class A, ai sensi della normativa FCC, Part 
15.

Dichiarazione relativa alle comunicazioni:
La presente apparecchiatura è stata collaudata e risulta 
conforme ai limiti previsti per i dispositivi digitali di Class A. 
Modifiche o cambiamenti apportati al prodotto senza 
l'autorizzazione di Digidesign Inc. possono annullare la validità 
della certificazione e il diritto ad utilizzare il prodotto.

Il prodotto è stato collaudato e risulta conforme a CISPR in 
diverse condizioni che includono l'utilizzo di dispositivi 
periferici e cavi nonché di connettori schermati tra i 
componenti del sistema.

Digidesign raccomanda l'impiego di cavi e connettori 
schermati tra i componenti del sistema per ridurre la 
possibilità di interferenze con radio, apparecchi televisivi e altri 
dispositivi elettronici.

Dichiarazione di sicurezza:
La presente apparecchiatura è stata collauda e risulta 
conforme all'attestazione di sicurezza statunitense e 
canadese in conformità con le specifiche degli standard UL; 
UL1419 e allo standard canadese CSA; CSA C22.2 No.1-M90 
e IEC950.



  
Importanti istruzioni per la sicurezza

Quando si utilizzano apparecchiature elettriche o elettroniche, 
è necessario rispettare sempre delle precauzioni minime, tra 
cui:
• Leggere tutte le istruzioni prima di utilizzare il dispositivo.
• Per evitare il rischio di scosse, tenere l'apparecchio 

lontano da acqua piovana e altre fonti di umidità. Non 
utilizzare l'apparecchio se è bagnato.

• L'apparecchio deve essere collegato solamente alla 
tensione di alimentazione corretta, come indicato sul 
prodotto.

• Non cercare di eseguire operazioni di manutenzione 
sull'apparecchio, in quanto non vi è alcuna parte la cui 
manutenzione può essere eseguita dall'utente. Per la 
manutenzione e/o riparazioni rivolgersi al personale 
autorizzato di Digidesign.

• Tentativi di riparazione dell'apparecchio comportano il 
rischio di scosse elettriche e annulleranno la garanzia del 
produttore.

• Il prodotto deve essere collegato solamente alla tensione 
di alimentazione corretta, come indicato sul prodotto.

• Non installare l'unità in prossimità di fonti di calore quali 
termosifoni, valvole di regolazione del calore, cucine o altri 
apparecchi (inclusi amplificatori) che producono calore.

• Adottare misure adeguate per impedire che il cavo di 
alimentazione venga calpestato o schiacciato, 
specialmente in prossimità di spine, prese multiple e punti 
di uscita dall'apparecchio.

• Installare l'unità in prossimità della presa di alimentazione 
in modo che sia possibile accedervi facilmente per 
disconnetterla.

• Per la pulizia utilizzare solo un panno umido.
• Scollegare l'apparecchio dalla presa elettrica durante i 

temporali o se non lo si utilizza per lunghi periodi.
• Non tentare di rimuovere il sistema di protezione della 

spina polarizzata. Una spina polarizzata presenta due poli, 
uno più grande dell'altro, e viene fornita a scopo di 
sicurezza. Se la spina fornita non entra nella presa 
elettrica, consultare un elettricista per sostituire la presa 
obsoleta.

NON OSTRUIRE LE FERITOIE DI VENTILAZIONE.
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capitolo 1

Introduzione

Edit Pack™ è una superficie di controllo 
aggiuntiva per i sistemi Pro Tools dotati di 
ProControl. 

Edit Pack presenta molte funzioni di missaggio e 
pan che consentono di migliorare i missaggi 
multicanale per il suono surround e di fornire 
accesso diretto a molti dei comandi e delle 
funzioni di Pro Tools più frequentemente 
utilizzati. 

Cosa contiene
Il sistema Edit Pack completo include:

• Superficie di controllo Edit Pack

• Guida di Edit Pack

• Cavo di alimentazione

• Cavo Ethernet

• Cavo USB

• Connettore loopback Ethernet (soltanto per 
test)

• Scheda di registrazione

Caratteristiche
Edit Pack presenta le seguenti caratteristiche 
principali: 

Panner

◆ Due joystick DigiPanners™ motorizzati 
sensibili al tocco per il pan. 

◆ Due sezioni panner complete, ciascuna con 
joystick DigiPanner e controlli per il pan 
completi. 

◆ Controlli di navigazione per la selezione e 
l'assegnazione delle tracce a Edit Pack. 

Meter

◆ Otto meter da 40 segmenti per il metering ad 
alta risoluzione delle uscite multicanale.

Tastiera e trackball

◆ Tastiera QWERTY, con tasti colorati 
personalizzati e una trackball da 1,5 pollici. 

Pulsanti

◆ 20 pulsanti Edit Function a doppia funzione.

◆ Pulsanti aggiuntivi dedicati per Machine 
Control, MIDI Event List, Track Height, Edit e 
Timeline Link e molte altre funzioni speciali. 
Capitolo 1: Introduzione 1
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Area visualizzazione

◆ Display di grandi dimensioni a 8 caratteri 
numerici per i valori di inizio, fine e lunghezza 
del montaggio o della timeline. 

Requisiti di sistema

Per utilizzare Edit Pack è necessario disporre di:

■ Un sistema Pro Tools dotato di ProControl, 
con Pro Tools versione 5.1 o successiva.

■ Un hub Ethernet con una porta disponibile 
per Edit Pack. 

■ Il file Edit Pack Controller Personality viene 
fornito con Pro Tools e deve essere installato 
nella sottocartella Controllers della cartella 
DAE. (Per ulteriori informazioni, vedere la 
sezione Capitolo 2, "Installazione di Edit Pack".)

Informazioni sulla compatibilità

Digidesign è in grado di garantire la 
compatibilità e fornire il supporto unicamente 
per il materiale hardware e software collaudato e 
approvato. Per un elenco dei computer, dei 
sistemi operativi e dei dispositivi di altri 
produttori approvati da Digidesign, consultare 
le informazioni sulla compatibilità più recenti 
nel sito Web di Digidesign:

www.digidesign.com/compato/

Registrazione del prodotto Digidesign

Compilare e restituire la scheda di registrazione 
fornita con Edit Pack. 

Informazioni sulla guida
Nella presente guida si presuppone che il 
sistema Pro Tools e ProControl siano già stati 
installati e che l'utente abbia familiarità con le 
funzioni e le convenzioni operative. Per ulteriori 
informazioni consultare la Guida di riferimento di 
Pro Tools e la Guida dell'utente di ProControl. 

Convenzioni utilizzate nella 
presente guida

In questa guida vengono utilizzate le seguenti 
convenzioni per indicare le scelte di menu e i 
comandi principali di Pro Tools:

Edit Pack richiede un'unità principale 
ProControl.

Nella Guida di Edit Pack non viene spiegato 
come utilizzare Pro Tools o ProControl. 
Prima di iniziare a utilizzare Edit Pack, si 
consiglia di familiarizzarsi con la 
terminologia, i concetti e le operazioni di 
base del sistema Pro Tools dotato di 
ProControl. Per ulteriori informazioni 
consultare la Guida di riferimento di 
Pro Tools e la Guida dell'utente di 
ProControl.

Convenzione Azione

File > Save Session Scegliere Save Session 
dal menu File

Control e N Tenere premuto il tasto 
Control e premere il 
tasto N

Opzione e clic Tenere premuto il tasto 
Opzione e fare clic con il 
pulsante del mouse

Clic destro (Windows) Fare clic con il pulsante 
destro del mouse
Guida di Edit Pack



            
I seguenti simboli sono utilizzati per evidenziare 
informazioni importanti:

Combinazioni di Edit Pack e ProControl

Nella presente guida ogni riferimento è relativo 
ai pulsanti di Edit Pack, eccetto dove altrimenti 
indicato (per alcune operazioni è possibile 
utilizzare uno o più pulsanti di ProControl). Per 
le operazioni che richiedono l'utilizzo di tasti 
modificatori della tastiera, è possibile utilizzare 
un tasto qualsiasi dei seguenti:

• I tasti modificatori sulla tastiera di Edit Pack 
(Shift, Cmd, Opt/Alt, Ctrl/Ctrl) 

• I tasti modificatori su una tastiera separata, se 
disponibile

• I tasti modificatori su ProControl (utilizzando 
i tasti nella sezione Tasti di scelta rapida), 
come indicato di seguito:

Suggerimenti per l'utente: consigli utili per 
ottenere il massimo da Edit Pack.

Le avvertenze importanti riportano 
informazioni che potrebbero avere un effetto 
sui dati di sessione di Pro Tools, di 
Edit Pack e sulle prestazioni del sistema 
Pro Tools.

I tasti di scelta rapida facilitano 
l'esecuzione delle operazioni.

I riferimenti incrociati rimandano a sezioni 
correlate delle guide di Edit Pack, 
ProControl o Pro Tools.

Modificatore 
(Mac/Win)

Scelte rapide ProControl

Shift SHIFT/ADD

Opzione (Macintosh)
Alt (Windows)

OPT(ALT)ALL

Comando (a Mac)
Ctrl (Windows)

a(CTL)

Control (Mac)
Avvio (Windows)

CTL/CLUTCH
Capitolo 1: Introduzione 3
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capitolo 2

Installazione di Edit Pack

Nel presente capitolo vengono fornite le 
istruzioni necessarie per l'installazione 
dell'hardware e del software di Edit Pack. 

Le seguenti istruzioni relative a Quick Start 
vengono fornite per coloro che hanno già 
familiarità con i sistemi espansi ProControl.

Quick Start

Hardware:

◆ Collocare Edit Pack il più vicino possibile alla 
posizione di monitoraggio primaria (sweet 
spot). Per ulteriori informazioni vedere 
"Installazione e linee guida di manutenzione" a 
pagina 5.

◆ Collegare a Edit Pack i cavi 
dell'alimentazione, Ethernet e USB o ADB (se si 
intende utilizzare la tastiera e la trackball). Per 
ulteriori informazioni vedere "Pannello 
posteriore di Edit Pack" a pagina 6.

Software:

◆ Assicurarsi che Pro Tools versione 5.1 (o 
versione successiva) sia installato correttamente 
e che il file Edit Pack Personality sia nella 
cartella Controllers, a sua volta nella cartella 
DAE. (Per ulteriori informazioni vedere 
"Installazione e linee guida di manutenzione" a 
pagina 5.) 

Accensione del sistema e determinazione della 
comunicazione

◆ Accendere il sistema nella sequenza corretta 
(vedere "Avvio e chiusura di un sistema" a 
pagina 7). Avviare Pro Tools e configurarlo per 
Edit Pack. (Per ulteriori informazioni vedere 
"Configurazione di Pro Tools per Edit Pack" a 
pagina 8.)

Installazione e linee guida di 
manutenzione
Se si colloca Edit Pack su mobili da studio o su 
un tavolo, attenersi alle seguenti linee guida:

• Non coprire le prese d'aria anteriori e 
posteriori.

• Non rimuovere i piedini di appoggio.

• Non collegare o scollegare i cavi della tastiera 
o della trackball (USB o ADB) quando l'unità 
CPU è accesa. 

• Le operazioni di pulizia e manutenzione di 
Edit Pack sono identiche a quelle di 
ProControl (vedere la Guida dell'utente di 
ProControl per ulteriori informazioni).
Capitolo 2: Installazione di Edit Pack 5
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Scelta della posizione di montaggio

Edit Pack deve essere collocato in una posizione 
facilmente raggiungibile dallo sweet spot 
dell'ambiente di missaggio. Nei sistemi 
ProControl più grandi è opportuno collocare 
Edit Pack accanto all'unità principale, con i 
Fader Pack ai lati (ma non in mezzo tra l'unità 
principale e l'unità Edit Pack). In seguito alla 
natura del missaggio multicanale per il suono 
surround (per il quale Edit Pack è stato 
realizzato), il monitoraggio del bilanciamento è 
di importanza fondamentale. 

Assemblaggio del sistema espanso

Edit Pack può essere fissato ad altre unità 
ProControl e Fader Pack mediante le staffe 
anteriori e posteriori fornite insieme a Edit Pack. 
Per le relative istruzioni vedere la Guida 
dell'utente di ProControl. 

Pannello posteriore di 
Edit Pack
Sul pannello posteriore si trovano i seguenti 
connettori:

ADB Porta per il collegamento della tastiera e 
della trackball di Edit Pack a un computer 
dotato di ADB.

USB Porta per il collegamento della tastiera e 
della trackball di Edit Pack a un computer 
dotato di USB.

PS-2 Non utilizzato (porte mouse e tastiera).

MAC/PC Selettore per la piattaforma con 
tastiera e trackball.

Ethernet Ciascuna unità Edit Pack è dotata di 
una porta Ethernet. 

Porta COM e LED Ethernet La porta COM viene 
utilizzata solo per la diagnostica di fabbrica. I 
LED Activity e Link indicano l'attività e lo stato 
Ethernet per la risoluzione dei problemi e i test 
di comunicazione. 

Alimentazione Con questo connettore è possibile 
utilizzare un cavo di alimentazione CA 
standard. Edit Pack, ProControl e i Fader Pack 
sono in grado di selezionare l'alimentazione in 
modo automatico (100 V–240 V) e funzionano 
automaticamente con cavi modulari standard 
per il collegamento a prese di corrente CA in 
tutti i Paesi. 

Collegamenti hardware
In Edit Pack sono necessari tre tipi di 
collegamenti (i relativi cavi sono forniti a 
corredo): 

• Alimentazione

• Ethernet. La comunicazione tra Edit Pack e 
Pro Tools avviene mediante un connettore 
standard RJ45, 10Base-T (identico a quello di 
ProControl e dei Fader Pack)

• Collegamenti della tastiera e della trackball 
(USB o ADB)

Prima di eseguire la connessione, verificare che 
Edit Pack e il computer siano spenti. 

Per collegare Edit Pack al sistema:

1  Collegare il cavo di alimentazione fornito a 
Edit Pack e a una fonte di alimentazione. Il 
connettore funziona con un cavo di 
alimentazione CA standard ed è in grado di 
selezionare l'alimentazione in modo 
automatico. 

Prima di collegare o scollegare il cavo della 
tastiera e della trackball (USB o ADB), 
verificare sempre che il sistema sia spento. 
Guida di Edit Pack



                                   
2  Per effettuare le connessioni Ethernet, fissare 
un'estremità del cavo RJ45 in dotazione a una 
porta dell'hub Ethernet. Non utilizzare porte 
riservate a funzioni Uplink. 

3  Collegare l'altra estremità del cavo RJ45 alla 
porta ETHERNET sul retro di Edit Pack.

4  Verificare che l'interruttore MAC/PC sia nella 
posizione MAC. 

5  Collegare il cavo della tastiera e della trackball:

■ Per i sistemi USB collegare un'estremità di un 
cavo USB compatibile alla porta USB di 
Edit Pack e collegare l'altra estremità a una porta 
USB disponibile sul computer (o a un adattatore 
per porta seriale approvato).

■ Per i sistemi ADB collegare la porta ADB di 
Edit Pack a una porta seriale disponibile sul 
computer. 

Installazione del software
Il programma di installazione di Pro Tools 
consente di installare automaticamente il 
software di Edit Pack come parte dell'opzione 
Easy Install. Con ciascuna release di Pro Tools il 
nuovo firmware Edit Pack è incluso nel file 
Edit Pack Personality. 

Se non si è ancora installato (o aggiornato) 
Pro Tools, interrompere l'installazione e 
consultare la Guida di installazione TDM. 
Attenersi alle istruzioni riportate di seguito per 
eseguire un'installazione Easy Install di 
Pro Tools. 

Se è stata eseguita un'installazione Custom 
Install di Pro Tools, è possibile che sia necessario 
aggiungere il file Edit Pack Personality al sistema 
Pro Tools già installato (versione 5.1 o 
successiva). 

Per installare il software di Edit Pack dal 
programma di installazione di Pro Tools:

1  Inserire il CD-ROM di installazione di 
Pro Tools nell'unità CD-ROM e avviare Pro Tools 
Installer. 

2  Scegliere Custom Install.

3  Selezionare Edit Pack e fare clic su Install.

Il programma di installazione consente di 
copiare il file Edit Pack Personality nella cartella 
Controllers. La cartella Controllers si trova nella 
cartella DAE dentro la Cartella Sistema. 

Avvio e chiusura di un 
sistema
Pro Tools è composto da diversi componenti 
che devono essere accesi e spenti uno alla volta: 
i dischi rigidi esterni, ProControl, i Fader Pack, 
Edit Pack e le interfacce audio e del computer. 
Per garantire una comunicazione corretta tra 
tutti questi dispositivi è importante avviare e 
spegnere il sistema nel seguente ordine:

Avviare il sistema Pro Tools nel seguente ordine:

1  Accendere i dischi rigidi esterni. Attendere dai 
10 ai 15 secondi affinché raggiungano la 
velocità di funzionamento. 

2  Accendere ProControl, i Fader Pack e quindi 
Edit Pack. 

3  Se si prevede di utilizzare apparecchiature 
MIDI, accendere le interfacce MIDI e gli altri 
dispositivi MIDI. 

Non utilizzare il cavo crossover fornito da 
Digidesign con ProControl (è dotato di 
margini rossi sensibili al calore su entrambe 
le estremità). Il cavo non funziona nei 
sistemi espansi.
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4  Accendere tutte le interfacce audio Pro Tools 
disponibili. 

5  Accendere il computer. 

6  Accendere gli altoparlanti/monitor.

Spegnere Pro Tools nel seguente ordine:

1  Spegnere gli altoparlanti/monitor.

2  Spegnere tutte le interfacce audio Pro Tools 
disponibili.

3  Spegnere il computer.

4  Se si utilizzano apparecchiature MIDI, 
spegnere le interfacce, i controller e gli altri 
dispositivi MIDI.

5  Spegnere ProControl (durante le fasi di 
accensione e spegnimento le uscite audio 
dell'unità principale vengono silenziate), i Fader 
Pack ed Edit Pack.

6  Spegnere i dischi rigidi esterni. 

Configurazione di Pro Tools 
per Edit Pack

Configurazione di Pro Tools per Edit Pack

1  Avviare il sistema nella sequenza descritta in 
"Avvio e chiusura di un sistema" a pagina 7. 

2  Avviare Pro Tools. 

3  Scegliere Setups > Peripherals, quindi fare clic 
sulla scheda Ethernet Controllers. 

4  Fare clic su Scan. 

5  Per attivare l'unità principale e gli eventuali 
Fader Pack presenti, selezionarli mediante i 
relativi selettori. (Per ulteriori informazioni 
sull'attivazione delle unità vedere la Guida 
dell'utente di ProControl.)

6  Per inizializzare Edit Pack, sceglierlo mediante 
il selettore Edit Pack posto nella parte inferiore 
della finestra Ethernet Controllers. 

7  Fare clic su OK per chiudere la finestra di 
dialogo Peripherals. Se il firmware Edit Pack 
deve essere aggiornato, viene visualizzato un 
messaggio in cui viene chiesto se si desidera 
aggiornarlo. 

Firmware di Edit Pack

Ciascuna versione di Pro Tools comprende il 
firmware più aggiornato di Edit Pack (e 
ProControl). Una volta attivato Edit Pack nella 
finestra di dialogo Peripherals, il firmware di 
tutte le unità connesse viene confrontato con la 
versione disponibile in Pro Tools. Se sono 
diverse, viene suggerito di scaricare il nuovo 
firmware per aggiornare le unità. 

Test del sistema

Per testare la comunicazione di base:

1  Verificare di avere installato e configurato 
Edit Pack come descritto nelle sezioni 
precedenti del presente capitolo. 

2  Avviare la sessione demo fornita con 
Pro Tools.

Inizializzazione di Edit Pack nella scheda > Ethernet 
Controllers della finestra Peripherals
Guida di Edit Pack



3  Premere la barra spaziatrice di Edit Pack. La 
riproduzione dovrebbe avere inizio. 

Se la riproduzione non inizia, controllare i 
collegamenti della tastiera e della trackball (USB 
o ADB) e riprovare. 

Per testare i panner: 

1  Nella sezione dei Panner a sinistra premere 
TRACK SEL. 

2  Ruotare la manopola SEL/ADJUST per scorrere 
tutte le tracce disponibili. Scorrere fino a 
quando nel display Channel Name non viene 
visualizzata una traccia mono con assegnazione 
dell'uscita multicanale. 

3  Premere nuovamente TRACK SEL per far sì 
che l'uscita della traccia selezionata sia attivata 
in Edit Pack.

L'uscita principale sulla traccia selezionata è ora 
l'uscita attiva (il focus) su cui avranno effetto 
tutte le azioni eseguite con il panner sinistro. 
Sullo schermo l'uscita correntemente attiva è 
evidenziata con un contorno di colore 
arancione (arancione e viola se si tratta di un 
canale stereo) nella vista I/O della finestra Mix. 

4  Avviare la riproduzione e iniziare il pan con 
Edit Pack. 

Focus di Edit Pack

Quando un'uscita o una mandata è la traccia 
attiva per uno dei panner di Edit Pack, l'uscita o 
la mandata viene spesso definita come focus del 
controller. 

Quando sono selezionate le tracce stereo, i due 
canali diventano il focus (ossia sono attive) di 
entrambi i panner. Inoltre è possibile impostare 
il focus dei panner su due uscite distinte di 
mandate o tracce mono. 

Per impostare il focus di entrambi i panner 
indipendentemente:

1  Impostare il focus del panner 1 su una traccia 
mono come descritto nelle istruzioni 
precedenti. 

2  Premere TRACK SEL nel panner 2. 

3  Selezionare una traccia per il panner 2 
premendo il pulsante di selezione del canale 
corretto su ProControl. Questo è un altro modo 
per impostare il focus di un panner su una 
traccia.

4  Dare inizio alla riproduzione e iniziare il pan 
con Edit Pack. 

Panner e controlli per la selezione delle tracce

TRACK SEL

SEL/ADJUST

Panner 1 Panner 2

Nell'esempio viene mostrato solamente uno 
dei metodi disponibili per selezionare tracce, 
mandate e uscire da Edit Pack. Tutti i 
metodi e le istruzioni dettagliate su tutti i 
parametri di pan sono spiegati nel 
Capitolo 4, "Pan con Edit Pack".
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capitolo 3

Nozioni di base

Nel presente capitolo viene fornita una 
panoramica di Edit Pack e un'introduzione ai 
principali controlli e sezioni. 

Nella Figura 1 a pagina 12 viene mostrata la 
posizione di ciascuna sezione principale. 
Capitolo 3: Nozioni di base 11
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Edit Pack

Meter

Otto meter a LED ad alta risoluzione da 40 
segmenti, con un pulsante CLR METER 
dedicato. I 26 segmenti inferiori sono verdi, i 13 
segmenti centrali sono gialli e il LED superiore 
consiste in un unico indicatore di clipping 
rosso. La scala si basa su incrementi di 1 dB da 0 
a –30, di 3 dB da –33 a –53 e su un salto da 7 dB 
da –53 a –60.

Display Start, End e Length

Tre display numerici a otto segmenti. I pulsanti 
corrispondenti consentono di selezionare il 
focus della selezione Timeline o Edit, nonché il 
collegamento Edit e Timeline. Per ulteriori 
informazioni vedere "Pulsanti Start, End e 
Length" a pagina 13. 

Figura 1.  Sezioni principali di Edit Pack

Meter

Valori Start, End e 
Length 

Tastiera

Trackball

Funzioni Edit

Panner

Joystick
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Panner

Due sezioni panner identiche, ciascuna con 
joystick, manopole e controlli commutabili. Per 
una spiegazione dei panner vedere il Capitolo 4, 
"Pan con Edit Pack".

Tastiera e trackball

Tastiera e trackball della superficie di controllo 
possono essere utilizzati come complemento o 
in sostituzione della tastiera e del mouse del 
computer. La tastiera è composta da tasti 
colorati personalizzati che mostrano tasti di 
scelta rapida del focus comandi di Pro Tools e 
altre funzioni. Utilizzare la tastiera per 
denominare le tracce, le sessioni e le 
impostazioni, immettere commenti e testo di 
altra natura, nonché per il focus comandi e altri 
tasti di scelta rapida. 

Sezioni dei pulsanti
Le sezioni dei pulsanti forniscono un unico 
accesso a numerosi comandi audio e MIDI. Tra i 
pulsanti sono inclusi controlli dedicati e a 
doppia funzione. 

Sezioni dei pulsanti primari Un totale di diciotto 
pulsanti forniscono controllo dedicato e 
costante sui parametri riportati sugli stessi. Tra 
questi vi sono pulsanti nella sezione Machine 
Control, i pulsanti Start, End e Length e altri. 
Vedere "Sezioni dei pulsanti primari" a 
pagina 13. 

Pulsanti delle funzioni Edit Le sezioni dei 
pulsanti di funzione Edit e TR/F forniscono 
controlli a doppia funzione per il montaggio 
comune e i task di sessione. La funzione è 
determinata dal pulsante MAIN/ALT. Vedere 
"Sezioni dei pulsanti della funzione Edit" a 
pagina 15.

Sezioni dei pulsanti primari

Pulsanti Start, End e Length

Consentono di immettere la modalità di 
immissione del tempo per il contatore 
correntemente selezionato, come determinato 
dal pulsante EDIT/T LINE. 

◆ Quando il pulsante EDIT/T LINE non è 
evidenziato, viene attivata la modalità di 
selezione Edit. In tale modalità i contatori e i 
pulsanti Start, End e Length consentono di 
visualizzare e modificare la selezione Edit. 

◆ Quando il pulsante EDIT/T LINE è 
evidenziato, viene attivata la modalità di 
selezione Timeline. In tale modalità i contatori e 
i pulsanti Start, End e Length consentono di 
visualizzare e modificare la selezione Timeline. 

◆ Quando il pulsante LINK EDIT/T LINE è 
abilitato (evidenziato), vengono collegate 
entrambe le selezioni Edit e Timeline. Il focus 
dei campi Start, End e Length rimane sul 
contatore correntemente selezionato, come 
determinato dal pulsante EDIT/T LINE. Quando 
non è evidenziato, le selezioni Edit e Timeline 
non sono collegate. 

Per modificare i valori del contatore Timeline o 
Edit:

1  Selezionare la modalità Edit o Timeline 
utilizzando il pulsante EDIT/T LINE oppure 
abilitare LINK EDIT/T LINE. 

2  Premere START per accedere al primo campo 
temporale di inizio (Start) nel contatore 
selezionato (Edit o Timeline). 

Pulsanti Start, End e Length
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3  Utilizzare la tastiera o il tastierino numerico di 
ProControl per immettere i valori desiderati, 
quindi premere il tasto di invio per confermare.

4  Ripetere la procedura sopra esposta per End e 
Length. 

Pulsanti Utility

Pan Win, Escape, MIDI Event List e Loc Util

PAN WIN Consente di aprire o chiudere le 
finestre Output di Edit Pack correntemente 
attivate. Per chiudere tutte le finestre Output, 
premere OPT(ALT)ALL+PAN WIN. 

MIDI EVENT LIST Consente di aprire la finestra 
MIDI Event List.

ESCAPE Quando il pulsante ESCAPE lampeggia, 
consente di uscire dalla finestra di dialogo o dal 
comando. Il pulsante corrisponde al pulsante 
ESCAPE di ProControl o al pulsante ESC della 
tastiera del computer.

LOC UTIL Consente di accedere alle opzioni di 
utilità di Edit Pack. La modalità Utility viene 
spiegata nell'Appendice A, "Utility locali."

Machine Control

La sezione Machine Control viene posizionata 
nella parte superiore di Edit Pack, tra le sezioni 
dei pulsanti TR/F e delle funzioni Edit.

Pulsanti Pan Window, Escape, MIDI Event List e Utility

Pulsanti Machine Control

Descrizione comandi di Machine Control e la relativa 
funzione

Pulsante Funzione

EXT TRANS Consente di attivare/disattivare 
External Transport (finestra 
Transport)

AUTO PUNCH Consente di attivare/disattivare 
Auto Punch (finestra Track Arming)

MFI Consente di attivare/disattivare 
Machine Follows Insertion/Scrub 
(Preferences > Operations)

INSERT 
ASSEM

Consente di attivare/disattivare 
Insert Assemble (finestra Track 
Arming)

Per ulteriori informazioni su queste 
funzioni, vedere la Guida di 
MachineControl.
Guida di Edit Pack



Clear Meters e All Notes Off

CLR METERS  Consente di azzerare tutti gli 
indicatori della clip su Edit Pack, ProControl, 
Fader Packs e a video su Pro Tools. Il pulsante 
corrisponde al pulsante F1 di ProControl e alla 
selezione del pulsante Opzione mentre si fa clic 
sull'indicatore della clip visualizzato. 

ALL NOTES OFF Consente di silenziare qualsiasi 
nota MIDI incollata inviando il messaggio All 
Notes Off a ciascun canale per i dispositivi 
installati. Il pulsante corrisponde al comando 
All Notes Off del menu MIDI di Pro Tools. 

Track Size Up/Down

Track Size Up e Track Size Down Consentono di 
aumentare o diminuire l'altezza della traccia 
nella finestra Edit della traccia o delle tracce in 
cui è posizionato il cursore Edit. 

Auto Suspend

AUTO SUSPEND Consente di sospendere 
temporaneamente la riproduzione 
dell'automazione e la registrazione. Il pulsante 
corrisponde al pulsante AUTO SUSPEND di 
ProControl e al controllo Suspend nella finestra 
Automation Enable di Pro Tools. 

Sezioni dei pulsanti della 
funzione Edit
In Edit Pack sono presenti venti diversi pulsanti 
di funzione Edit per eseguire numerosi comandi 
e funzioni di Pro Tools. Le quattro sezioni di 
funzione Edit, oltre alla sezione TR/F, 
forniscono accesso diretto a numerosi comandi 
di Pro Tools, altrimenti non direttamente 
accessibili tramite la modalità di focus dei 
comandi. 

Clear Meters e All Notes Off

Pulsanti Track Size Up/Down

Auto Suspend

Sezioni Tr/F a sinistra e funzione Edit a destra
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Pulsanti MAIN/ALT e funzione Edit

I pulsanti presenti in queste sezioni sono 
pulsanti a doppia funzione. Il pulsante 
MAIN/ALT, posizionato tra le sezioni Machine 
Control e Misc, consente di selezionare il 
comando con il nome riportato nella sezione 
superiore o inferiore. 

Informazioni sui pulsanti TR/F

Nonostante i pulsanti della sezione TR/F non 
siano pulsanti di funzione Edit veri e propri, 
sono comunque pulsanti a doppia funzione 
utilizzabili in modalità Main/Alt. 

Per selezionare la funzione Edit Main (superiore) o 
Alt (inferiore):

■ Premere il pulsante MAIN/ALT fino a quando 
il pulsante non si accende (modalità Main) o 
non inizia a lampeggiare (modalità Alt). 

• In modalità Main, ovvero quando il pulsante 
è acceso, i pulsanti di funzione Edit 
consentono di eseguire i comandi il cui nome 
è riportato nella riga superiore, mentre i 
pulsanti TR/F sono in modalità TR (Track 
Arming). 

• In modalità Alt, ovvero quando il pulsante 
lampeggia, i pulsanti di funzione Edit 
consentono di eseguire i comandi il cui nome 
è riportato nella riga inferiore, mentre i 
pulsanti TR/F sono in modalità F (Function).

Pulsanti TR ed F
Modalità Main, preparazione delle tracce I 
pulsanti sono equivalenti agli stessi pulsanti 
della finestra Track Arming di Pro Tools, con 
funzioni di visualizzazione aggiuntive. 

Modalità Alt, F1-8 I pulsanti di funzione 
forniscono la selezione della modalità Pan 
inversa. Per ulteriori informazioni sul 
collegamento e sul collegamento inverso, 
vedere "Collegamento inverso" a pagina 27.

Preparazione remota delle tracce 
(Machine Control)

In modalità Main questi pulsanti corrispondono 
agli stessi pulsanti della finestra Track Arming di 
Pro Tools. Questi pulsanti forniscono anche il 
seguente display di stato delle tracce remote:

◆ Quando la traccia è preparata, ma non in 
registrazione, lampeggerà il pulsante TR 
corrispondente su Edit Pack.

◆ Durante la registrazione, il pulsante smette di 
lampeggiare e rimane acceso finché non si 
interrompe la registrazione. 

Pulsante MAIN/ALT per le funzioni Edit

Pulsanti di funzione e di preparazione delle tracce
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La preparazione delle tracce richiede l'opzione 
MachineControl di Digidesign. Per ulteriori 
informazioni sui dispositivi remoti di 
preparazione delle tracce con Pro Tools, vedere 
la Guida di MachineControl. 

Pulsanti F

In modalità Alt i pulsanti F forniscono la 
selezione della modalità Link inversa. Vedere 
"Collegamento dei panner" a pagina 27. 

Misc e Audio
Modalità Main, Misc Bounce to Disk, Shift, 
Duplicate Track, New Track e Auto/Input 
(attivazione/disattivazione della modalità 
Monitor).

Modalità Alt, Audio Convert and Import Audio, 
Import Other, Import Track, Time Stamp 
Selected e Beat Detective.

Visualizzazione della modalità di monitoraggio 
Input

Il pulsante AUTO/INP è acceso per indicare la 
modalità Input Only, mentre se non è acceso 
indica la modalità Auto Input.

Pulsanti Misc e Audio

Descrizione comandi MISC e la relativa funzione

Descrizione 
comando 
Main

Funzione

BOUNCE File > Bounce to Disk

SHIFT Edit > Shift

DUP TRK File > Duplicate Track

NEW TRK File > New Tracks

AUTO/INP Alterna Auto Input o Input Only

Descrizione comandi AUDIO e la relativa funzione

Descrizione 
comando 
Alt

Funzione

CONV IMP Regions List > Convert & Import 
Audio

IMP OTHER Movie > Import Other Audio from 
Movie

IMP TRK File > Import Tracks

T STAMP Regions List > Time Stamp Selected

BEAT DET MIDI > Beat Detective
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Region-Show/Hide e MIDI-Edit
Modalità Main, Region-Show/Hide Consolidate, 
Heal, Show Only Selected Tracks, Hide Selected 
Tracks e Show All Tracks.

Modalità Alt, MIDI-Edit  Select Note, Split Note, 
Transpose, Merge Paste e Input Quantize.

Edit e MIDI-Change
Modalità Main, Edit Trim, Duplicate, Repeat, 
Insert Silence e Fill with Paste.

Modalità Alt, MIDI-Change Tempo, Meter, 
Velocity, Duration e Quantize.

Pulsanti Region-Show Hide e MIDI-Edit

Descrizione comandi REGION SHOW/HIDE e la relativa 
funzione

Descrizione 
comando 
Main

Funzione

CONS Edit > Consolidate Selection

HEAL Edit > Heal Separation

SHOW SEL Show Only Selected Tracks

HIDE SEL Hide Selected Tracks

SHOW ALL Show All Tracks

Descrizione comandi MIDI-EDIT e la relativa funzione

Descrizione 
comando Alt

Funzione

SEL NOTE MIDI > Select Note

SPL NOTE MIDI > Split Notes

TRANS MIDI > Transpose

MRG/PSTE Edit > Merge Paste

INP QUANT MIDI > Input Quantize

Pulsanti Edit e MIDI Change

Descrizione comandi EDIT e la relativa funzione

Descrizione 
comando 
Main

Funzione

TRIM Edit > Trim

DUPL Edit > Duplicate

REPEAT Edit > Repeat 

INS SILNCE Edit > Insert Silence

F PASTE Edit > Repeat Paste to Fill 
Selection

Descrizione comandi MIDI-CHANGE e la relativa 
funzione

Descrizione 
comando Alt

Funzione

TEMPO Finestra di dialogo Change Tempo

METER Finestra di dialogo Change Meter

VEL Finestra di dialogo Change Velocity

DUR Finestra di dialogo Change 
Duration

QUANT Finestra di dialogo Quantize
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Auto-Write e Plug-In
Modalità Main, Auto-Write Start, All, End, 
Current e All Enabled. 

Modalità Alt, Plug-In Copy, Paste, Compare, Save 
e Save As.

Auto Write

Questi pulsanti sono tasti di scelta rapida per 
numerose funzioni di automazione utili, incluse 
la funzione di scrittura Start, End e All manuale 
e On Stop.

Start, All, End In modalità predefinita 
(manuale) questi pulsanti sono equivalenti agli 
stessi pulsanti presenti nella finestra 
Automation Enable di Pro Tools. 

Current e All Enabled Il pulsante Current 
corrisponde a Edit > Write Automation to 
Currently Enabled Parameter (Command+/). All 
Enabled corrisponde a Edit > Write Automation 
to All Parameters (Control+Command+/).

Auto Write On Stop

I pulsanti Auto-Write consentono anche di 
abilitare e applicare uno qualsiasi dei comandi 
Auto Write On Stop. 

Per attivare una modalità On Stop:

■ Premere Ctrl+START, ALL o END. 

Il pulsante lampeggia per indicare che la 
modalità On Stop è abilitata. 

Per disattivare il passaggio di scrittura di 
automazione On Stop:

■ Premere il pulsante lampeggiante START, ALL 
o END. 

Auto Suspend

Il pulsante AUTO SUSPEND si trova a destra dei 
pulsanti Auto-Write e consente di abilitare le 
modalità Suspend All Automation o All 
Automation Enabled. Inoltre corrisponde allo 
stesso pulsante di ProControl e al pulsante 
presente nella finestra Automation Enable di 
Pro Tools. 

Pulsanti Auto Write e Plug-In

Descrizione comandi AUTO-WRITE e la relativa funzione

Descrizione 
comando 
Main

Funzione (Finestra Automation 
Enable)

START Write Automation to Start

END Write Automation to End

ALL Write Automation to All

CURRENT Write Automation to Currently 
Enabled

ALL ENAB Write Automation to All Enabled

Descrizione comandi Plug-In e la relativa funzione

Descrizione 
comando Alt

Funzione (nella finestra Plug-In 
Target)

COPY Copy Settings

PASTE Paste Settings

COMPARE Compare

SAVE Save Settings

SAVE AS Save Settings As
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Per interrompere l'automazione:

■ Premere AUTO SUSPEND quando Pro Tools 
non è in funzione. 

Il pulsante lampeggia quando l'automazione 
viene interrotta. È possibile annullare la 
funzione Auto Suspend premendo uno dei 
pulsanti lampeggianti.
Guida di Edit Pack



capitolo 4

Pan con Edit Pack

In Edit Pack sono presenti due sezioni dove si 
trovano i panner, ognuno dotato di un joystick 
DigiPanner, una manopola e dei controlli 
commutabili.

Focus dei panner mono e stereo

Le due sezioni panner possono essere attivati 
indipendentemente per eseguire il pan di 
qualsiasi uscita delle mandate o delle tracce di 
una data sessione. 

Quando le tracce attive (tracce di destinazione) 
di Edit Pack sono tracce stereo, la parte a sinistra 
e a destra sostituiscono le destinazioni correnti 
del panner (i due lati del percorso stereo 
vengono assegnati a entrambe le sezioni destra e 
sinistra dei panner, sostituendo eventuali 
destinazioni precedenti). Se poi si imposta come 
destinazione un panner mono, sostituendo uno 
dei lati di una destinazione stereo, l'uscita 
selezionata verrà visualizzata e verrà attivata la 
modalità mono doppia. 

Pan con Edit Pack e ProControl

Le destinazioni di Edit Pack (gli elementi su cui 
agisce) sono indipendenti dalle destinazioni e 
dalle selezioni di canali di ProControl e 
Pro Tools (sullo schermo). Questo significa che è 
possibile definire come destinazione una traccia 
stereo per le sezioni dei panner in Edit Pack 
(occupando entrambe le sezioni dei panner) e 
definire come destinazione l'uscita di una 

traccia mono in ProControl (DSP Edit/Assign). 
Oppure, se necessario, è possibile definire come 
destinazione tre canali sulle due superfici di 
controllo. 

Visualizzazione a colori del focus di Edit Pack

Le destinazioni correnti di Edit Pack, chiamate 
anche focus, vengono indicate sullo schermo 
con un contorno a due colori (arancione e 
viola), uno per ciascuno dei due panner. 

Il colore della destinazione di ProControl varia a 
seconda del numero di unità presenti. (Per 
ulteriori informazioni consultare la Guida 
dell'utente di ProControl.)

È possibile che più controlli abbiano come 
destinazione contemporaneamente la stessa 
uscita. Quando Edit Pack e ProControl (o altre 
superfici di controllo) hanno come 
destinazione, ossia agiscono sulla stessa uscita, 
tale uscita viene evidenziata con un contorno di 
colore bianco. 
Capitolo 4: Pan con Edit Pack 21



22
Selezione di uscite di 
mandate e tracce nei panner
In Edit Pack vi sono diversi modi per assegnare 
le uscite di Pro Tools ai panner, descritti nelle 
sezioni seguenti. Tali modalità includono: 

• Utilizzo della trackball e dei tasti modificatori 
per selezionare sullo schermo le finestre 
Output, per renderle la destinazione dei 
panner di Edit Pack.

• Selezione delle tracce, per eseguire il pan della 
loro uscita principale.

• Selezione di uscite specifiche principali delle 
tracce o delle mandate.

Focus dei panner su schermo

È possibile definire il focus di Edit Pack 
utilizzando il mouse per selezionare una finestra 
Output correntemente aperta. 

Per impostare il focus del primo panner (di 
sinistra) in una finestra Output:

■ Fare clic sull'intestazione grigia di una finestra 
Output aperta (non fare clic su alcun controllo, 
solo sullo sfondo di colore grigio scuro). 

L'uscita viene assegnata automaticamente al 
primo joystick (di sinistra). Se l'uscita 
selezionata viene assegnata a una traccia stereo, 
entrambe le sezioni del panner ed entrambi i 
joystick agiranno su tale uscita, ossia l'uscita sarà 
la loro destinazione. 

È possibile regolare i parametri in altre finestre 
Output senza ridefinire il focus di Edit Pack 
(purché non si faccia clic sull'intestazione della 
finestra). 

Per impostare il focus del secondo panner (di 
destra) su una finestra Output:

■ Premere il tasto Comando e fare clic 
sull'intestazione della finestra Output 
desiderata. 

Le mandate e le uscite delle tracce stereo 
verranno sempre assegnate a entrambi i panner. 

Per aprire e impostare contemporaneamente il 
focus in una finestra Output:

■ Fare clic sull'icona Output di qualsiasi traccia 
mono per aprirla come focus del panner 1. Se la 
traccia è stereo, focus sarà su entrambi i panner. 

■ Premere il tasto Comando e fare clic sul 
l'icona Output di qualsiasi traccia mono per 
aprirla come focus del panner 2. Se la traccia è 
stereo, il focus sarà su entrambi i panner. 

Visualizzazione del focus di Edit Pack

Le uscite principali della traccia o della mandata 
che sono il focus corrente in Edit Pack vengono 
visualizzate nelle finestre Mix ed Edit di 
Pro Tools con due colori (uno per ciascun 
panner). 

• Il focus del panner 1 è evidenziato con un 
contorno arancione.

• Il focus del panner 2 è evidenziato con un 
contorno viola.

• Quando un'uscita è il focus di più panner (o di 
più superfici di controllo), viene evidenziata 
con un contorno bianco. 

Area su cui fare clic per definire il focus di un panner

fare clic qui per impostare il focus
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Selezione delle tracce da Edit Pack

Il focus dei panner può essere impostato sulle 
uscite della mandata o principali della traccia 
direttamente da Edit Pack oppure in 
combinazione con i pulsanti di ProControl. 

◆ Il metodo di ProControl consente di 
selezionare le tracce direttamente dalle file di 
canali di ProControl o dalla Channel Matrix. Si 
tratta di un metodo particolarmente utile nelle 
sessioni di notevoli dimensioni, nelle quali lo 
scorrimento è troppo lento. 

◆ I controlli della sezione dei Panner 
consentono di scorrere le uscite sulle altre tracce. 

Per selezionare le tracce:

1  Premere il pulsante TRACK SEL (accanto alla 
manopola SEL/ADJUST). Viene così attivata la 
modalità di selezione delle tracce per il panner 
corrente. 

2  Per selezionare una traccia, eseguire una delle 
operazioni seguenti:

• Ruotare la manopola SEL/ADJUST per scorrere 
tutte le tracce disponibili. Quando la traccia 
desiderata viene visualizzata, premere 
nuovamente TRACK SEL per impostare il 
focus sull'uscita principale di quella traccia.

• In ProControl premere SELECT nella fila di 
fader corretta per impostare il focus sull'uscita 
principale di quella traccia.

• In ProControl utilizzare Channel Matrix per 
selezionare il focus sull'uscita della traccia 
principale della traccia corrispondente. 

Una volta selezionata, l'uscita principale della 
traccia viene assegnata alla sezione dei panner. 

Selezione delle uscite delle tracce da 
Edit Pack

È possibile assegnare alle tracce di Pro Tools una 
o più uscite principali e fino a cinque mandate. 
Anche a ogni mandata è possibile assegnare più 
uscite. Una volta selezionata una traccia, 
Edit Pack agirà sull'uscita della traccia a cui è 
stato assegnato il numero più elevato di canali 
di uscita (quando alla traccia sono state 
assegnate più uscite). Ad esempio, se una traccia 
(o una mandata) viene assegnata sia a un 
percorso di uscita stereo che a un percorso di 
uscita 5.1, l'uscita 5.1 diventa la finestra Output 
master per quella traccia e sarà il focus della 
selezione di Edit Pack.

Display e strumenti per la navigazione

Pulsante Page e controlli di navigazione nei panner

TRACK SEL

SEL/ADJUST

PAGE

MAIN / SEND

TRACK SEL
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Per selezionare l'uscita principale della traccia 
corrente:

1  Selezionare la traccia di cui si desidera eseguire 
il pan utilizzando i metodi descritti in "Selezione 
delle tracce da Edit Pack" a pagina 23. 

2  Premere MAIN per impostare come 
destinazione l'uscita principale della traccia, se 
presente. 

Per impostare il focus su un'assegnazione diversa 
dell'uscita principale della traccia:

■ Premere MAIN e la freccia sinistra o destra per 
scorrere le altre tracce della sessione. 

Le finestre Output vengono visualizzate 
automaticamente quando diventano il focus 
solo dopo il rilascio del pulsante MAIN o SEND. 
Una volta rilasciati i pulsanti, le finestre 
vengono visualizzate in base alle seguenti 
regole:

◆ Quando si esegue lo scorrimento con il 
panner 1, la finestra Output selezionata viene 
visualizzata oppure rimane chiusa in base al 
pulsante PAN WIN (se PAN WIN è evidenziato, 
le finestre Output vengono visualizzate, se non è 
evidenziato, rimangono chiuse.) 

◆ Quando si esegue lo scorrimento con il 
panner 2, la finestra Output selezionata viene 
visualizzata automaticamente con il relativo 
Target (destinazione) deselezionato. 

Selezione delle mandate da Edit Pack

È possibile selezionare uscite delle mandate 
differenti per il pan da Edit Pack eseguendo le 
seguenti operazioni. 

Per selezionare la mandata A (Send A) nella 
traccia corrente:

■ Premere SEND per impostare il focus 
sull'ultima mandata impostata come focus nel 
panner. Se non è stata assegnata alcuna mandata 
nella traccia corrente, viene visualizzato il 
messaggio "no sends" (nessuna mandata).

Per scorrere le mandate disponibili:

■ Premere MAIN e la freccia su o giù per scorrere 
le mandate disponibili nella traccia corrente. 

Impostazione del focus con MAIN e 
SEND

In Edit Pack è possibile scorrere le uscite delle 
tracce e delle mandate in altre tracce utilizzando 
i pulsanti MAIN e SEND e i tasti delle frecce della 
propria tastiera. 

Per scorrere tutte le tracce di una sessione:

■ Premere MAIN e la freccia sinistra o destra per 
scorrere tutte le tracce (incluse quelle senza 
alcuna assegnazione di uscita o di mandata). 

Per scorrere tutte le uscite delle mandate di una 
sessione:

■ Premere SEND e la freccia sinistra o destra per 
scorrere le mandate di altre tracce. 

Per ulteriori informazioni su Pro Tools e le 
assegnazioni di più uscite, consultare la 
Guida di riferimento di Pro Tools.

Per ulteriori informazioni sulla 
destinazione consultare la Guida di 
riferimento di Pro Tools.
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Chiusura e apertura delle finestre 
Output

Quando si imposta come destinazione un'uscita 
da Edit Pack, la finestra Output associata viene 
visualizzata automaticamente sullo schermo. 
Per chiudere o visualizzare la finestra corrente di 
destinazione di Edit Pack, lasciando inalterata 
l'uscita definita come destinazione nella sezione 
dei panner, utilizzare il pulsante PAN WIN. 

Per chiudere (o aprire) la finestra Output corrente:

■ Premere PAN WIN.

Per chiudere tutte le finestre Output:

■ Premere il tasto Opzione e PAN WIN.

Il pulsante PAN WDW indica inoltre gli stati 
correnti della finestra (aperta o chiusa). Per 
ulteriori informazioni vedere "Finestra Pan" a 
pagina 29.

Pan
Edit Pack consente di accedere a tutti i controlli 
di pan di Pro Tools, tra cui la selezione delle 
modalità, il pan controllato da manopole o 
joystick, i parametri di divergenza, percentuale 
centro ed LFE. 

Joystick

I DigiPanner sono panner a joystick motorizzati 
sensibili al tocco, che consentono di eseguire il 
pan a 360° dell'audio di Pro Tools. 

Per eseguire il pan con i joystick:

1  Selezionare l'uscita principale o di mandata di 
una traccia usando i metodi descritti in 
"Selezione di uscite di mandate e tracce nei 
panner" a pagina 22.

2  Eseguire il pan con il joystick. Il controllo del 
joystick è sensibile al tocco e il pan mediante il 
joystick segue le impostazioni di Touch Time-
out e Auto Match. 

Per eseguire il pan con le manopole:

1  Selezionare l'uscita di una mandata o di un 
canale usando i metodi descritti in "Selezione di 
uscite di mandate e tracce nei panner" a 
pagina 22. 

2  Selezionare un parametro di pan premendo il 
pulsante desiderato FRONT, REAR o F/R 
(Front/Rear).

3  Ruotare SEL/ADJUST per regolare il parametro 
di pan correntemente selezionato. 

Panner Parametri di pan e SELECT ADJ

SEL/ADJUST
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Modalità pan e i joystick

Pro Tools supporta le modalità di pan X/Y e 3-
Knob per il pan surround. Questa modalità, 
spiegate nella Guida di riferimento di Pro Tools, 
sono disponibili due modi diversi per eseguire il 
pan nel suono surround. 

È possibile passare dalla modalità X/Y a quella 3-
Knob e viceversa in qualsiasi momento. 

Per scegliere la modalità di pan desiderata:

1  Premere PAGE finché non è illuminato, a 
indicare la modalità Page 2. 

2  Premere C% (Mode).

3  Ruotare SELECT ADJ per selezionare una 
modalità (X/Y, Divergence o 3-Knob). 

Pan a 3 manopole con il joystick

Quando la modalità 3-Knob è attivata, Pro Tools 
consente di filtrare gli spostamenti del joystick 
al di fuori della traiettoria di pan. I DigiPanner 
non limitano fisicamente la traiettoria durante 
la scrittura di dati. Durante la riproduzione 
seguono la traiettoria automatizzata. 

Divergenza, centro e LFE 

I pulsanti per i parametri di pan consentono di 
selezionare il focus della manopola 
SEL/ADJUST. Il pulsante PAGE consente di 
selezionare la funzione superiore o inferiore dei 
pulsanti dei parametri di Pan.

Per selezionare i parametri di pan superiori o 
inferiori (page 1 o page 2):

■ Premere PAGE. Il pulsante PAGE non è 
evidenziato quando è selezionata la funzione 
superiore (page 1) e ed è evidenziato quando è 
selezionata la funzione inferiore (page 2). 

Per regolare la divergenza:

1  Selezionare l'uscita di una mandata o di una 
traccia usando i metodi descritti in "Selezione di 
uscite di mandate e tracce nei panner" a 
pagina 22. 

2  Premere PAGE finché non è evidenziato per 
attivare la modalità Page 2. 

3  Selezionare un parametro di pan premendo il 
pulsante desiderato F DIV, R DIV oppure F/R 
DIV.

4  Ruotare SEL/ADJUST. 

Per regolare Center%:

1  Selezionare l'uscita di una mandata o di una 
traccia usando i metodi descritti in "Selezione di 
uscite di mandate e tracce nei panner" a 
pagina 22. 

2  Premere PAGE finché non è evidenziato, per 
attivare la modalità Page 2.

3  Premere C%. 

4  Ruotare SEL/ADJUST. 

Per regolare il livello LFE:

1  Selezionare l'uscita di una mandata o di una 
traccia usando i metodi descritti in "Selezione di 
uscite di mandate e tracce nei panner" a 
pagina 22. 

2  Verificare che sia attiva la modalità Page 1 (il 
pulsante PAGE non deve essere evidenziato).

3  Premere LFE. 

4  Ruotare SEL/ADJUST.
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Collegamento dei panner
Il pulsante LINK PANNERS consente il 
collegamento diretto e inverso dei panner. 
Quando è attivato, Edit Pack copia lo 
spostamento fisico di un joystick in un altro 
joystick. Quando due joystick sono collegati, 
l'automazione viene scritta sia per il joystick che 
viene fisicamente toccato che per quello non 
toccato (collegato). È possibile attivare o 
disattivare il collegamento in qualsiasi 
momento. 

Pro Tools consente di collegare i due lati di una 
traccia stereo per il pan collegato in modo 
diretto e inverso. Con Edit Pack è possibile 
collegare in modo diretto e inverso due tracce 
mono. Quando due tracce mono vengono 
collegate nei panner di Edit Pack, se si toccano 
entrambi i joystick mentre sono collegati, viene 
temporaneamente disattivato il 
comportamento "collegato". Non appena si 
rilascia uno dei joystick, questo passerà subito 
alle coordinate del joystick toccato. 

Collegamento assoluto

Quando i panner sono collegati, i dati di 
automazione identici vengono passati da un 
panner all'altro (questa operazione è nota con il 
nome di collegamento assoluto). 

Collegamento e pan inverso di tracce mono

In Pro Tools viene fornita la funzione di 
collegamento dei panner solamente nelle 
finestre Output. Tuttavia con Edit Pack è 
possibile impostare il focus su due uscite mono 
distinte e collegarle dalla sezione dei panner. 

Tracce stereo

Sullo schermo il collegamento delle tracce stereo 
e il collegamento inverso vengono controllati 
dalle icone Link di ciascuna finestra Output.

Per collegare i panner:

1  Impostare la destinazione dei panner come 
descritto in "Selezione di uscite di mandate e 
tracce nei panner" a pagina 22. 

2  Premere il pulsante LINK PANNERS.

Collegamento inverso

In Edit Pack è supportata la funzione di 
collegamento inverso di Pro Tools, in base alla 
quale gli spostamenti di panning sulle tracce 
stereo sono invertiti da un panner (o lato) 
all'altro. In Edit Pack è stata aggiunta la 
possibilità di collegare due tracce mono. 
Quando si collegano due tracce mono, i joystick 
supportano tutte le modalità di collegamento 
normale e inverso. (Le modalità di collegamento 
e di collegamento inverso non sono supportate 
dalle manopole SEL/ADJUST quando si 
collegano due tracce mono; le manopole 
SEL/ADJUST supportano solo il collegamento 
dei lati di una traccia stereo.)

Controlli di collegamento nelle finestre Output

Display e strumenti per la navigazione

Link 

F/R invert

Front inverse

Rear inverse

Link Panners
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Quando il pulsante LINK PANNERS è attivato, 
sono disponibili le tre modalità di collegamento 
inverso: Front, Rear e Front/Rear. Le modalità 
inverse possono essere utilizzate singolarmente 
o insieme. 

Invert Front (anteriore inverso)

Disponibile nelle tracce di tutti i formati (mono, 
stereo e multicanale). 

Per attivare il collegamento Invert Front:

1  Premere il pulsante MAIN/ALT per attivare la 
modalità Alt.

2  Premere F1.

Invert Rear (posteriore inverso)

Disponibile solo nei formati multicanale con 
due o più canali posteriori distinti. 

Per attivare il collegamento Invert Rear:

1  Premere il pulsante MAIN/ALT per attivare la 
modalità Alt.

2  Premere F2.

Invert Front/Rear (anteriore/posteriore 
inverso)

Disponibile solo nei formati multicanale con i 
canali surround (posteriori). 

Per attivare il collegamento Invert Front/Rear:

1  Premere il pulsante MAIN/ALT per attivare la 
modalità Alt.

2  Premere F3.

Track Fader, assolo, 
silenziamento e automazione
Edit Pack consente di controllare il 
silenziamento, l'assolo e il volume del canale e la 
modalità di automazione da ogni sezione dei 
panner. 

Per impostare l'assolo alla traccia corrente:

■ Premere SOLO nel panner desiderato. 

Per impostare il silenziamento della traccia 
corrente:

■ Premere MUTE nel panner desiderato.

Per regolare il livello di traccia o mandata:

1  Premere il pulsante MAIN/ALT per attivare la 
modalità Alt.

2  Premere LFE/VOL.

3  Ruotare SELECT ADJ. 

Per cambiare la modalità di automazione della 
traccia:

■ Utilizzare il pulsante AUTO per selezionare la 
modalità di automazione desiderata per il canale 
correntemente impostato come destinazione. 

È possibile configurare l'automazione delle 
tracce da Edit Pack o da ProControl sullo 
schermo. Il pulsante Edit Pack AUTO è 
particolarmente utile per eseguire il punch 
out dell'automazione.
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Finestra Pan
Oltre all'apertura e alla chiusura delle finestre 
Output, il pulsante PAN WIN e il relativo LED 
indicano lo stato aperto o chiuso delle finestre 
nel seguente modo:

PAN WIN evidenziato Indica che sullo schermo è 
aperta almeno una finestra Output 
correntemente impostata come destinazione da 
Edit Pack. Se si imposta come destinazione una 
nuova uscita, viene visualizzata tale finestra 
Output. Se si preme PAN WIN quando è 
evidenziato, le finestre Output impostate come 
destinazione in Edit Pack vengono chiuse (ma 
l'uscita rimane impostata in Edit Pack).

PAN WIN non evidenziato Indica che sullo 
schermo non sono aperte finestre Output 
correntemente impostate come destinazione da 
Edit Pack. Se si imposta come destinazione una 
nuova uscita, viene visualizzata tale finestra 
Output. Se si preme PAN WIN quando non è 
evidenziato, l'uscita correntemente definita 
come uscita (se presente) viene aperta.

Per chiudere tutte le finestre Output 
correntemente aperte:

■ Premere il tasto Opzione e PAN WIN.
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appendice a

Utility locali

In Edit Pack viene fornita una funzione Utilities 
per personalizzare la risposta, il contrasto di 
visualizzazione e la modalità Sleep, nonché per 
eseguire le routine di test per LED, meter e altre 
funzioni. 

Utility e test

Per entrare in modalità Utilities:

1  Premere LOC UTIL. Nei LED Panner vengono 
visualizzate le selezioni Utilities. 

2  Selezionare un'opzione premendo il pulsante 
MAIN lampeggiante sotto ciascuna selezione. 
Per visualizzare le altre opzioni di utility, 
premere PAGE.

Per selezionare Com ed FDR:

1  Premere LOC UTIL. 

2  Premere il pulsante MAIN lampeggiante sotto 
l'opzione SYSTEM visualizzata in Panner 1. Le 
versioni del sistema vengono visualizzate per la 
durata della pressione del pulsante MAIN.

Per immettere un nome personalizzato per 
Edit Pack:

1  Premere LOC UTIL per attivare la modalità 
Utilities.

2  Premere MAIN per selezionare NAME (in 
Panner 2). Il nome dell'unità corrente (il nome 
predefinito è EDITPACK) viene visualizzato in 
Panner 2. Il primo carattere lampeggia, 
indicando che si tratta del focus di montaggio.

3  Selezionare i caratteri utilizzando Panner 1 
SELECT ADJ. Per spostare il cursore (la lettera 
lampeggiante), ruotare Panner 2 SELECT ADJ. 

Utility di test

In Edit Pack vengono fornite le routine di test 
integrate per i LED, i pulsanti e i joystick. 

Per eseguire i test contenuti in Edit Pack:

1  Premere LOC UTIL per attivare la modalità 
Utilities.

2  Premere PAGE fino a quando non viene 
visualizzata la pagina 2/2. In Panner 1 viene 
visualizzata la voce TEST. 

3  Selezionare TEST premendo MAIN in Panner 
1. I test disponibili vengono visualizzati su 
pagine differenti del test di Utility dei LED. 
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• Per sottoporre i LED al test, visualizzare la 
pagina 1/3 del test, quindi selezionare un LED 
premendo il pulsante MAIN lampeggiante 
sotto il Panner 1. Premere PAGE per 
selezionare un test di LED specifico (Vegas, 
Switch test, Red, Yellow, Green o All). 

• Per testare i display dei meter o dei timecode 
di Edit Pack, premere LOC UTIL+PAGE, 
quindi premere il pulsante MAIN 
corrispondente per selezionare TEST. Premere 
DISPLAY, quindi selezionare un test di display 
utilizzando il pulsante MAIN corrispondente. 

• Per testare i joystick, premere LOC 
UTIL+PAGE+TEST, quindi premere PAGE fino 
a quando non viene visualizzata la voce 
JOYSTICK in Panner 1. Premere il pulsante 
MAIN lampeggiante, quindi selezionare un 
test di joystick. SELECT/ADJ consente di 
controllare la velocità di esecuzione del test. 

• Per testare le manopole rotatorie, premere 
LOC UTIL+PAGE+TEST, quindi premere PAGE 
fino a quando non viene visualizzata la voce 
ROTARIES in Panner 2. Premere il pulsante 
MAIN lampeggiante in Panner 2, quindi 
regolare una delle manopole rotatorie di 
Edit Pack. I risultati vengono visualizzati nei 
panner.

Per ripristinate le impostazioni predefinite di 
fabbrica di Edit Pack:

■ Premere LOC UTIL+PAGE per visualizzare la 
pagina 2/2, quindi selezionare RESET. Seguire le 
istruzioni mostrate nei display dei panner.

Preferenze di Edit Pack

È possibile personalizzare le preferenze di 
Edit Pack. Sono disponibili le impostazioni per il 
contrasto di LED, la modalità Sleep e la risposta 
dei joystick. 

Per regolare le preferenze di Edit Pack:

1  Premere LOC UTIL+PAGE per visualizzare la 
pagina 3/3, PREFS.

2  Premere il pulsante MAIN lampeggiante per 
selezionare l'opzione PREFS.

• Per regolare il contrasto o la luminosità del 
LED, premere MAIN per selezionare 
CONTRAST e ruotare SELECT/ADJ su Panner 1 
per aumentare o diminuire il contrasto del 
LED di Edit Pack.

• Per configurare la modalità Sleep di Edit Pack, 
premere MAIN in Panner 1 per selezionare 
SLEEP, quindi ruotare SELECT/ADJ (Panner 2) 
per selezionare un tempo Sleep (le opzioni 
selezionabili sono comprese tra un minuto e 
12 ore).

• Per regolare la risposta del joystick, premere 
PAGE per visualizzare la pagina 2/2 delle 
preferenze, JOYSTICK. Premere il pulsante 
MAIN lampeggiante per selezionare 
JOYSTICK. Ora ruotare una delle manopole 
SELECT/ADJ per aumentare o diminuire la 
tensione del joystick. 
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Dimensioni di Edit Pack 

Lunghezza, profondità e altezza di Edit Pack

15,13" l x 25,04" p x 7,10" h

38,4 cm l x 63,6 cm p x 18 cm h

Queste dimensioni sono identiche a quelle delle 
unità di espansione Fader Pack (Edit Pack 
presenta le stesse dimensioni di console e 
telaio). Se si stanno progettando o costruendo i 
mobili per lo studio di registrazione basato sul 
sistema ProControl ed Edit Pack, è possibile 
visualizzare i relativi schizzi con le dimensioni 
dettagliate sul sito Web di Digidesign. 

Sul sito Web di Digidesign sono disponibili 
gli schizzi corredati da dimensioni 
dettagliate. 
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installazione del software 7
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